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THE U.P.M.A.C.S. OPERATE SYSTEM 

Introduction 

U.P.M.A.C.S. acquires information from equipment over Ethernet or serial ports 
of the computer, and displays and processes it visually. It can interface with vir-
tually any equipment that provides an RS232, RS422, or RS485 serial interface 
or Ethernet interface for remote control. It makes alarm and status information 
available to the operator in an intuitive, user-friendly fashion, and it allows him to 
do any control tasks with the click of a button. U.P.M.A.C.S. can also do automat-
ic controlling, like redundant backup switching, or even complicated and lengthy 
power leveling. 

U.P.M.A.C.S. can automate virtually any task, and display almost any kind of in-
formation as concisely or with as much detail as desired. 

How does U.P.M.A.C.S. achieve its groundbreaking versatility and short devel-
opment time? 

Traditional monitor, alarm, and control software solutions rely on hard-coded 
functionality. One program can only monitor and control one station, and any 
change in equipment or functionality means a return to the drawing board. 
U.P.M.A.C.S., however, reads information about the configuration and functional-
ity of a station to be monitored from a proprietary database file, an U.P.M.A.C.S. 
Station File. This file contains information about the visual display of data, about 
interface protocols required to communicate with the equipment, about port con-
figurations and polling sequences, and about every other aspect of the function-
ality of the system. It even contains control and data evaluation programs, written 
in U.P.M.A.C.S.’s own, BASIC-like programming language, SCL. In other words, 
U.P.M.A.C.S. can monitor and control almost every thinkable arrangement of 
equipment with the appropriate station file. 

Station files can be easily developed using the visual U.P.M.A.C.S. Development 
System, available from UPMACS Communications Inc. The Development Sys-
tem makes developing device drivers, screens, and programs as easy as one, 
two, three. Station files can be developed by anyone who owns a Development 
System, or UPMACS Communications Inc. can develop them in-house. 

U.P.M.A.C.S. also allows remote monitoring and controlling over any TCP based 
network. Any U.P.M.A.C.S. system can connect to any number of other 
U.P.M.A.C.S. station on the network. It even supports connections to groups of 
redundant computers. 
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BASIC TASKS 

Installing, Running and Activating U.P.M.A.C.S.  Operate and 
Develop Software v6.2.4 

• To install U.P.M.A.C.S., you may have to have Administrator privileges on your com-
puter. If you are not an Administrator, log off, and log back on as an Administrator.  

• Download UPMACS installation ZIP file from UPMACS web site 
http://upmacs.com/wp-content/uploads/2016/05/UPMACS_Installation-2025-A.zip 

• Unzip all files into a unique folder possibly off of Downloads folder. 

• Right-click on file "Install_UPMACS.exe” and select Run as Administrator. The 
U.P.M.A.C.S. install program will guide you through the installation step by step. 
IMPORTANT: Be sure to select option to install both Operate and Develop software. 

• U.P.M.A.C.S. is now installed and can be started from Start Menu. IMPORTANT: 
Right-Click on Operate_System.exe and select Run as Administrator. 

• You will be prompted once first time to select an UPMACS Log file. This file will con-
tain any and all UPMACS Operate events. Just enter any name for now. This can be 
changed later. 

• You may sign-on in UPMACS Operate using testuser for both the user-name and 
password. This temporary user account may be deleted later once you create your 
own user database 

•  

•  

 

 

http://upmacs.com/wp-content/uploads/2016/05/UPMACS_Installation-2025-A.zip
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Once U.P.M.A.C.S. is installed, you will be able to run it as a fully functioning program 
for 10 days. IMPORTANT: Right-Click on Operate or Develop and select Run as Ad-
ministrator. After this 10 day period you must activate UPMACS Operate or Develop. 
Clicking on “Activate UPMACS Operate/Develop” will provide you with two User 
Codes. These two User Codes must be emailed to support@upmacs.com. You will 
then receive an email with an Activation Code. You can then enter this activation 
code which will activate a perpetual UPMACS Operate or Develop license on the com-
puter where UPMACS was installed.  

Monitoring a Local Station 

To monitor equipment connected to the serial ports of your computer, you need 
to load an appropriate station file. Choose “Open Station...” from the “File” menu, 
and select the station file that you wish to use. U.P.M.A.C.S. will immediately 
begin polling the equipment, and writing events to the log file. To stop monitoring 
the station, choose “Close Station”, also from the “File” menu. 

You can also select a station file from the recent file list at the bottom of the “File” 
menu. Just select the file, and U.P.M.A.C.S. will load it. Another way to open a 
station file is to double-click on its icon in an explorer window. The icon for station 
files looks like this: 

 

The U.P.M.A.C.S. station file icon 

You can also grab the file with the mouse and drag it to the U.P.M.A.C.S. win-
dow. 

Once the file has been loaded, U.P.M.A.C.S. will start polling the equipment. 

Connecting To a Remote Station 

You can connect to other computers running U.P.M.A.C.S. over a TCP/IP net-
work. You can look at the screens of the remote system, and sign on to 
acknowledge alarms and execute controls. You cannot connect to a computer 
that does not have a local station file loaded, even if U.P.M.A.C.S. is running. 

If the remote computer is not responding, U.P.M.A.C.S. will keep trying to con-
nect until a connection has been established successfully. If the remote computer 
drops the connection, U.P.M.A.C.S. will immediately try to reconnect, until the 
connection is established again. 

If you wish to connect to a remote station, select “Connect To...” from the “File” 
menu. A dialog entitled “Connect Remote Station” will appear. 

mailto:support@upmacs.com
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There are two different dialogs for connecting to a remote station. Which dialog 
appears depends on the settings in the advanced preferences. The simple Con-
nect Remote Station dialog is used to connect to a single computer. The redun-
dant Connect Remote Station dialog is used to connect to a station that has re-
dundant backup computers. 

Some computers require you to enter a user name and password in order to 
connect to them. The user name and password must be assigned to you on the 
computer you are connecting to, not the local computer. Ask the administrator of 
the remote station to assign you a user name and password. 

If you enter an incorrect user name and password, U.P.M.A.C.S. will disconnect 
the station temporarily. Press the “Reconnect” button in the Remote Stations dia-
log to try to reconnect. See Viewing and Closing Remote Stations on page 10 for 
details. 

Connecting to a Single Computer 

The simple Connect Remote Station dialog looks like this: 

 

▪ Connect to: 
Enter the name or internet (IP) address of the computer you want to connect to. 
Ask your network administrator or refer to the documentation that came with your 
computer for information about network names and internet addresses. 

You can select a station name you recently entered from a drop down menu by 
clicking on the button with the down arrow. 
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You can also select a computer from the “Select computer” list instead 

▪ Connect as: 
Enter the name that you want to call the remote station here. This name will ap-
pear in the screen windows and log messages that belong to the remote station. 

Note: If you do not enter a name in this field, you will not be able to press 
the OK button. 

▪ Reconnect every time U.P.M.A.C.S. starts: 
Check this box if you wish to connect automatically to the station every time you 
run U.P.M.A.C.S. 

▪ Cache station on the hard disk: 
When U.P.M.A.C.S. connects to a remote station, the station information is 
transmitted over the network. If you have a slow connection to the remote com-
puter, this could take a while. If you check this box, U.P.M.A.C.S. will save the 
station information on the hard disk the first time you connect, so that it does not 
need to be retransmitted every time. This will dramatically reduce the time need-
ed to connect. 

Only cache stations that take a long time to transmit. Caching a station that is re-
ceived over an Ethernet connection, for example, is a waste of disk space and 
will not increase the performance. 

▪ Use local images: 
This option is only used when connecting to versions of U.P.M.A.C.S.. prior to 
v5.5.15. See Appendix C: Image Libraries on page 62 for details. 

▪ Log only alarm messages when first connecting: 
Usually U.P.M.A.C.S. writes all status and alarms of the remote station to the log 
as soon as you connect. This may not be desirable if you have a slow network 
connection or if you connect and disconnect often. If you check this check box, 
U.P.M.A.C.S. will log only alarm messages when you first connect. Subsequent 
status changes will be logged as normal, this check box only affects the messag-
es that are written to the log when you connect. 

▪ Select computer: 
U.P.M.A.C.S. tries to find computers that you can connect to on the network for 
you. You can select a computer from this list instead of entering the name into 
the “Connect to” field. 
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If you are signed on to U.P.M.A.C.S. as an administrator, there will be an extra 
check box in the dialog: 

 

▪ Require administrator clearance to close: 
Check this box to prevent users who do not have administrator clearance to dis-
connect from this station. 

Redundant Remote Computers 

U.P.M.A.C.S. supports connections to stations that have multiple redundant 
backup computers. If the main computer fails, or if a connection cannot be estab-
lished with it, U.P.M.A.C.S. will try to connect to all the backup computers in the 
order in which you specified them, until a successful connection has been estab-
lished. If U.P.M.A.C.S. is connected to a backup, and that backup goes off line, it 
will try to reconnect to the primary. If the primary is still not available, all backups 
are tried again, in order. 

U.P.M.A.C.S. will never stop trying to connect to computers. Even if all comput-
ers are off-line, U.P.M.A.C.S. keeps attempting connections to each of them in 
turn, until one responds. 

To connect to a station using redundant computers, you must select the appro-
priate option in the advanced preferences. Refer to Appendix A: Advanced Pref-
erences on page 53 for details on how to do this. 

Select “Connect To...” from the “File” menu to show the Connect Remote Station 
dialog. 
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The redundant Connect Remote Station dialog looks like this: 

 

▪ Connect station as: 
Enter the name that you want to call the remote station here. This name will ap-
pear in the screen windows and log messages that belong to the remote station. 

Note: If you do not enter a name in this field, you will not be able to press 
the OK button. 

▪ Select computers: 
This list shows all the computers on the network that U.P.M.A.C.S. can connect 
to. If a computer you wish to connect to does not appear in the list, press the 
“Other...” button. 

To add a computer to the “Connect to”, select it here, and press the “Add” button. 
You can also double click on the computer to add it. 

▪ Connect to: 
This list shows all the computers that U.P.M.A.C.S. will try to connect to. The top 
computer in the list is the primary, all the backups are listed beneath it in order. 
You can grab and drag the computer names to change their order. 

To add a computer to the list, select it in the “Select computers” list, and press 
the “Add” button. To remove a computer, select it and press the “Remove” but-
ton. Double clicking on a computer will also remove it. 

To add a computer that is not shown in the “Select computers” list, press the 
“Other...” button and enter the computer’s name or internet (IP) address. 
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▪ Reconnect every time U.P.M.A.C.S. starts: 
Check this box if you wish to connect automatically to the station every time you 
run U.P.M.A.C.S.. 

▪ Cache station on the hard disk 
When U.P.M.A.C.S. connects to a remote station, the station information is 
transmitted over the network. If you have a slow connection to the remote com-
puter, this could take a while. If you check this box, U.P.M.A.C.S. will save the 
station information on the hard disk the first time you connect, so that it does not 
need to be retransmitted every time. This will dramatically reduce the time need-
ed to connect. 

Only cache stations that take a long time to transmit. Caching a station that is re-
ceived over an Ethernet connection, for example, is a waste of disk space and 
will not increase the performance. 

▪ Use local images: 
This option is only used when connecting to versions of U.P.M.A.C.S.. prior to 
v5.5.15. See Appendix C: Image Libraries on page 62 for details. 

▪ Log only alarm messages when first connecting: 
Usually U.P.M.A.C.S. writes all status and alarms of the remote station to the log 
as soon as you connect. This may not be desireable if you have a slow network 
connection or if you connect and disconnect often. If you check this check box, 
U.P.M.A.C.S. will log only alarm messages when you first connect. Subsequent 
status changes will be logged as normal, this check box only affects the messag-
es that are written to the log when you connect. 

If you are signed on to U.P.M.A.C.S. as an administrator, there will be an extra 
check box in the dialog: 

 

▪ Require administrator clearance to close: 
Check this box to prevent users who do not have administrator clearance to dis-
connect from this station. 
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Viewing and Closing Remote Stations 

You can view and close remote stations by selecting “Remote Stations...” from 
the “File” menu. The Remote Stations dialog will appear. 

 

▪ Connections: 
Shows all remote stations in alphabetical order. Stations that are currently com-
municating with a remote computer are marked with a little picture of two con-
nected plugs with green connectors. Stations that do not have a connection, ei-
ther because the connection has not yet been established, or because none of its 
remote computers could be reached, are marked with disconnected plugs with 
red connectors. In the example shown, the computer for the KU-01 System is 
down, or the station on that computer has been closed. 

▪ The “Details...” button: 
Press this button to see which computer the selected station is connected to. The 
Remote Station Details dialog will appear: 
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The dialog shows a list of all computers, beginning with the primary, followed by 
all the backups in order. Computers with which the connection failed are shown 
in red. The computer that the station is connected to, if any, is shown in black, 
and marked with an arrowhead. Backups that U.P.M.A.C.S. didn’t try to establish 
a connection with (because the primary or an earlier backup responded) are 
shown in grey. 

If U.P.M.A.C.S. is currently receiving the station information from a computer, 
that computer is be shown in grey, marked with an arrowhead, and a progress 
bar shows the progress of the data transfer. 

▪ The “Disconnect” button: 
Press this button to disconnect the station temporarily. The station will remain 
disconnected until you press the “Reconnect” button. 

▪ The “Reconnect” button: 
Press this button to reconnect a disconnected station. A station will be discon-
nected if an error occurred receiving it over the network, if you entered an incor-
rect user name and password for a station that requires a user name and pass-
word to connect, or if you disconnected the station manually using the “Discon-
nect” button. 

You can also press this button to disconnect from the selected station’s current 
computer and try to reconnect to the primary computer. 

▪ The “Delete” button: 
Press this button to disconnect the selected station permanently, and delete it 
from the list. If you delete the last station, the dialog disappears. 

Navigating Screens 

The indicators and controls for a station are organized in screens. Each screen 
can be shown in a window. You can open as many windows as you want. 

Most stations will be configured to open one or more windows for you automati-
cally . These windows will appear as soon as you load the station file or connect 
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to the station. Each window will show a screen, usually a system overview or 
summary screen. 

Changing the Screen Shown in a Window 

You can change the screen shown in a particular window by selecting it from the 
screen pop-up menu on the Tool Bar: 

the screen pop-up menu
 

You can cycle through all the screens in a station by selecting “Previous Screen” 
and “Next Screen” from the “View” menu, or by pressing the Page Up and Page 
Down keys. 

Opening a New Window 

To open a new window, or to view a screen when there are no windows open, 
choose “New Window...” from the “Window” menu. You will be asked to select 
the screen that you wish to view. 

If there are any alarms on a screen, it will be shown in red. All the screens that 
are already shown in a window will have a little picture of a window next to them. 
If you select a screen that already has a window, U.P.M.A.C.S. will bring that 
window to the front, rather than opening a new one. 

If you are connected to any remote stations, the New Screen dialog will also 
include a “Station” pop-up menu. Select the station to which the screen you want 
to view belongs to. 
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Arranging Windows 

If you have changed the size of a window, and would like the window to be 
exactly the right size for the screen again, select “Autosize” from the “Window” 
menu. 

To neatly stack the windows in a pile, select “Cascade” from the “Window” menu. 
To arrange the windows so that they don’t overlap, select “Tile Horizontally” or 
“Tile Vertically” from the “Window” menu. 

Jumping to Alarms 

You can quickly jump to the next unacknowledged alarm by selecting “Next 
Alarm” from the “View” menu, or by pressing F2. Doing this repeatedly will take 
you through all screens that have unacknowledged alarms on them. 

The Log 

U.P.M.A.C.S. logs every important event. The date and time, and a message will 
appear in the log window, and will be written to the log file. Events that happen 
on the local station are logged, and so are events from remote stations. 

U.P.M.A.C.S. can be configured to process and log all events using Greenwich 
Mean Time (GMT). This option must be set by the administrator in the advanced 
preferences. Refer to Appendix A: Advanced Preferences on page 53 for details 
on how to set this option. 
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The Log Window 

 

The log window displays the most recent log messages. You can specify the 
number of messages displayed in the preferences. 

Alarm and error messages are displayed in red. When an alarm clears or an er-
ror disappears, a green message is logged. If you acknowledge an alarm, a 
message is logged in orange. If you load or connect to a station, or if you close a 
station, an event is logged in blue. Other events may be logged in various col-
ours, depending on the station file. 

The log window is a “dockable” window. You can grab its frame, and “tear” it 
away from the U.P.M.A.C.S. window, to float in its own little window. If the log 
window is floating, you can “dock” it to the U.P.M.A.C.S. window again by moving 
it near the bottom of the U.P.M.A.C.S. window. You can also double-click in the 
title bar of the log window to dock it. 

If you want to prevent the log window from docking itself when you drag it, hold 
down the Ctrl key. 

When the log window is docked, you can resize it by dragging the splitter bar that 
separates it from the rest of the U.P.M.A.C.S. window. 

To hide the log window, or to show it once you hid it or closed its floating window, 
select “Log Window” from the “View” menu. 

The Log File 

The first time you run U.P.M.A.C.S., It will ask you to select a log file. You can 
enter any log file name you want. You can use an existing file, or you can create 
a new file. Some examples of names for log files are “Upmacs Logfile.txt” and 
“MyStation.log”. U.P.M.A.C.S. will remember the name of the log file, so you 
don’t have to enter it every time you start U.P.M.A.C.S.. 

All log messages are written to the log file. You can view the log file using the 
Log File Browser (UpmacsLB.exe), or any text editor. To view the log file with the 
Log File Browser, select “Log File Browser” from the “View” menu. 

By default, the log file will never be erased. This means that eventually, it will fill 
up your entire hard disk. To prevent this, you can specify a maximum size for the 
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log file. Once the maximum size has been reached, the older half of the log mes-
sages are removed. See Appendix A: Logging Preferences on page 52 for de-
tails. 

You can change the log file at any time from within the preferences. 

Signing On As a Registered User 

U.P.M.A.C.S. has a built-in user database. To perform certain tasks, you must 
sign on as a registered user. What tasks exactly require you to sign on, depends 
on the user privileges, maintained by the administrator. Usually, you will have to 
sign on to perform any control actions. You may also have to sign on to 
acknowledge alarms, or to do diagnostics or to configure the system. 

Signing On and Off 

To sign on as a registered user, select “Sign On...” from the “File” menu. 

If you are currently connected to any remote stations, a dialog will appear asking 
you to which station you wish to sign on. Sign-on information is kept separately 
for each station. The sign-on and user information for a remote station is main-
tained by the computer at that station. Signing on to the local station gives you 
control only over local equipment and configuration, not over that of remote sta-
tions. 

You have to be signed on to the station that you want to control. If you want to 
control a remote station, you have to sign on to that station, it is not enough to 
sign on to the <local> station. Conversely, to control the local station, you must 
be signed on locally, it is not enough to be signed on to a remote station. 

The user information for a remote station is also maintained by the computer at 
that location. Your user name and password on the local computer will not nec-
essarily work for a remote station. To sign on to a remote station, you must have 
been given a user name and password for that station by the administrator of that 
station. This user name and password may be different from the one the adminis-
trator of the local station gave you. 

To sign off, select “Sign Off” from the “File” menu. If you are signed on to any 
remote stations, you will be asked from which station you would like to sign off. 

User Clearance 

Each user has a clearance. The clearance is assigned by the administrator, who 
himself has “administrator” clearance. The administrator also determines which 
actions can be performed by users of what clearance. Some tasks, like disabling 
devices and configuring the stations, will usually be reserved for users with high-
er clearances. Your administrator decides what clearance you are assigned, and 
what actions you may perform with that clearance. 
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There are some tasks which can only be performed by a user with administrator 
clearance. This includes managing user information and privileges. 

Changing Your Password 

You can only change your password for the local station. To change your pass-
word for a remote station, you have to be at that station’s computer. 

To change your password, sign on to the local station, and select “Change 
Password...” from the submenu “Security” of the “Settings” menu. You will be 
asked to enter your old password, and your new password twice. The password 
must be at least five characters long, and is not shown as you type it. 

Once you have entered your password, it is encrypted, and no-one can find out 
what it is, not even the administrator. The administrator can change you pass-
word, he can even remove you entirely from the list of registered users, but he 
cannot tell what your current password is. This is important in case you want to 
use a password that you use elsewhere (say, for you email), and you don’t want 
anyone to know what it is. 

Sign-On Conflicts 

If you sign on to a station, you gain exclusive access to it. No two users can be 
signed on to any particular station at the same time. This prevents two users 
from performing controls on the same equipment at cross-purposes. If you try to 
sign on to a station where someone else is already signed on, one of three things 
will happen: 

 

1. If you are signing on to the local station, and someone is signed on from 
a remote computer, the remote user will be signed off. 

2. If you are signing on to a remote station, and someone with lower clear-
ance is already signed on from somewhere else, the other user will be 
signed off. 

3. If you are signing on to a remote station, and someone with higher or 
equal clearance is already signed on from somewhere else, you cannot 
sign on. 

 

Shifts 

You may have been assigned a shift length. If you have been assigned a shift 
length, you will automatically be signed off after your shift expires. This is done in 
case you leave the computer and forget to sign off. You can sign on again imme-
diately when your shift runs out. 

If you look at the right of the status bar (at the bottom of the U.P.M.A.C.S. win-
dow), you will see who his currently signed on, and how much time is left in the 
shift: 
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current user time left in the shift  

The status bar always shows the sign-on information for the station that the top-
most screen belongs to. If you are looking at a local screen, the user name and 
shift timeout are those for the local station. If you are looking at a screen from a 
remote station, the information pertains to that station. 

If you have no windows open, the user information shown in the status bar is for 
the local station. 

Emergency Sign-On 

The password information for U.P.M.A.C.S. is maintained in an encrypted data-
base. The default sign on is: 

User Name: testuser 

Password: testuser 
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Acknowledging Alarms 

When an alarm occurs, the alarm indicator that represents the alarm starts flash-
ing, and the audible alarm sounds. You can then acknowledge the alarm. Once 
an alarm has been acknowledged, it stops flashing and the audible alarm stops 
sounding. The acknowledged alarm will still be displayed as an alarm (e.g. in 
red), only it will not flash. 

To acknowledge all alarm on the current screen, select “Acknowledge Alarms” 
from the “Window” menu, or press F4. 

The administrator can set U.P.M.A.C.S. up so that not everyone can 
acknowledge alarms. You may have to sign on before you can acknowledge 
alarms. You have to be signed on to the station for which you want to 
acknowledge an alarm. If you want to acknowledge an alarm of a remote station, 
you have to sign on to that station, it is not enough to sign on to the <local> sta-
tion. Conversely, to acknowledge alarms of the local station, you must be signed 
on locally, it is not enough to be signed on to a remote station. 

Some alarms in the station may be latching alarms. Latching alarms do not clear 
until you acknowledge them, even if the fault condition disappears. This ensures 
that you will know that an alarm happened, even if you temporarily left the room 
and the fault cleared before you returned. 

Note: If you press any key when an alarm occurs, the audible alarm will 
cease to sound. This does not acknowledge the alarm. It merely turns off 
the beeping. 

Executing Controls 

Most stations will include controls as well as indicators. To execute a control, you 
simply press the corresponding button on the screen. The meaning and location 
of the buttons vary from station file to station file. 

Usually, you will have to sign on to a station to execute controls. If you are not 
signed on, the control buttons will be invisible. You have to be signed on to the 
station for which you want to execute a control. If you want to execute a control 
on a remote station, you have to sign on to that station, it is not enough to sign 
on to the <local> station. Conversely, to execute controls on the local station, you 
must be signed on locally, it is not enough to be signed on to a remote station. 

The Remote Station Status Window 

If you are connected to several remote stations, it is sometimes desirable to get a 
quick overview of which station has alarms. To do this, you can look at the Re-
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mote Station Status window. This window lists all stations on the network, and 
shows which ones have unacknowledged alarm on them. 

 

The stations with a red box next to them have unacknowledged alarms, the sta-
tions with green boxes do not. The box will be green even if the station has 
alarms, as long as all of them have been acknowledged. 

You can jump to the first alarm on a station with a red box by double-clicking on 
it. 

Capturing And Printing Screens 

You can capture and print any U.P.M.A.C.S. screen. Capturing refers to copying 
the screen to the clipboard, so you can paste it into MS Paint, Word, or any other 
program that supports graphics. 

To capture the screen, select “Capture” from the “Window” menu. 

To print the screen, first select “Page Setup...” from the “File” to specify the size 
and position of the screen on the printed page. Once you have selected the de-
sired setup, select “Print...” from the “File” menu. You cannot print or capture the 
content of dialogs. 

To print the content of the log window, open the log file using the Log File 
Browser (UpmacsLB.exe) in the U.P.M.A.C.S. directory. 
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ADVANCED TASKS 

Viewing Serial Port Information 

You can view information and status for all the serial ports using the Port Diag-
nostics dialog. You may have to sign on to the <local> station with sufficient 
clearance to access this dialog. Whether or not this is the case depends on the 
user privilege settings, maintained by the administrator. 

To show the Port Diagnostics dialog, select “Serial Ports...” from the “Settings” 
menu. 

 

▪ Serial port (the list): 
Select the serial port about which you want information. 

▪ Serial Port (the text field): 
Shows the hardware port (COM port) that is used for the serial port. 

▪ Baud rate: 
Shows the data rate setting of the port. 

▪ Flow control: 
Shows the flow control setting of the port. RTS/DTS and DTR/DSR are hardware 
flow control, XON/XOFF is software flow control. 

▪ Data bits: 
Shows the number of data bits used on the port. 
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▪ Parity: 
Shows the parity setting of the port. 

▪ Stop bits: 
Shows the number of stop bits used on the port. 

▪ Polls: 
Shows a list of all commands that are sent to the equipment. The list shows ei-
ther the initialization sequence, used to initialize the equipment, or the polling se-
quence, used for regular operation. Which sequence is shown depends on the 
radio buttons just above the list. 

The poll that is currently being sent has a little black arrowhead next to it. Polls 
that have timed out are shown in red, polls that were not sent are shown in grey. 

There is a field below the list box, that holds a message about the port status. 

▪ Initialization sequence: 
Press this radio button to display the initialization sequence in the “Polls” list. 

▪ Polling sequence: 
Press this radio button to display the polling sequence used for regular operation 
in the “Polls” list. 

▪ The “Close Port” / “Open Port” button: 
Press this button to close the serial port, or to reopen it once you closed it. You 
need to close the serial port if you want to temporarily use it for some other pro-
gram, like a setup program supplied by the equipment manufacturer. The port will 
be re-opened automatically when you close the Port Diagnostics dialog. 

▪ The “Suspend” / “Resume” button: 
Press this button to suspend or resume the polling process on the port. If polling 
is suspended, no polls are sent. Polling will be resumed automatically when you 
close the Port Diagnostics dialog, unless you have a Data Capture window open 
for the port. 

▪ The “Capture Data” button: 
Press this button to open a Data Capture window for the port. The Data Capture 
window is a data capture and protocol analyzer utility. See Using the Data Cap-
ture Utility on page 20 for details. 

▪ The “Terminal” button: 
Press this button to open a TTY terminal emulator for the serial port. Polling will 
be suspended as long as the terminal emulator is up. See Using the Terminal 
Emulator on page 21 for details. 

Using the Data Capture Utility 

U.P.M.A.C.S. has a built-in data capture utility that can serve as a protocol ana-
lyzer. The utility allows you to monitor and record all data transactions on a serial 
port with time stamp. This can be useful for debugging serial communications 
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problems. To use the data capture utility, press the “Capture Data” button in the 
Port Diagnostics dialog. See Viewing Serial Port Information on page 19 for a 
description of the Port Diagnostics dialog. 

The Data Capture window is an entirely separate top-level window. It is not con-
tained within the U.P.M.A.C.S. Operate System Window, and has its own button 
on the Windows Taskbar. 

 

See Appendix B: Data Capture Utility Reference on page 55 for details. 

Using the Terminal Emulator 

U.P.M.A.C.S. provides a simple TTY terminal emulator. To use the terminal emu-
lator, press the “Terminal” button in the Port Diagnostics dialog. See Viewing Se-
rial Port Information on page 19 for a description of the Port Diagnostics dialog. 

The terminal emulator uses either CR only, LF only, or CR/LF as line termination. 
The line termination setting is defined in the station file and cannot be changed 
from within the U.P.M.A.C.S. Operate System. 

Polling on a serial port will be suspended as long as you are using a terminal 
emulator for it. 
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To close the terminal window and resume polling, press the close button at the 
far right of the title bar. 

You can modify the following settings: 

▪ Local echo: 
Check this box to locally echo all characters sent to the port. If you leave this 
check box blank, the characters you enter will not appear in the terminal window 
unless the equipment connected to the port echos them remotely. 

If you cannot see the characters you type, check this box. If the characters you 
type appear twice, clear this box. 

▪ Line mode: 
The terminal emulator supports character or line mode: 

If this check box is blank, line mode is disabled and character mode is used. In 
character mode, every character you type is immediately sent to the port. 

If this check box is checked, line mode is used. In line mode, you enter text in the 
“Enter text” field, and it is only sent to the port (followed by the line termination) 
once you hit Enter. This allows you to edit the command lines for equipment that 
does not support command line editing. It also allows you to send the same text 
several times by hitting Enter repeatedly. 

▪ Enter text: 
In line mode, enter text to be sent to the port here. The text, followed by the line 
termination, is sent to the port once you hit Enter. You can edit the text, even if 
the equipment does not support command line editing. To send the same text 
several times, hit the Enter key repeatedly. 
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Disabling Devices 

If not all the equipment (devices) specified in the U.P.M.A.C.S. station file is ac-
tually attached to the computer, the missing devices should be disabled. Disa-
bled devices are not polled, and all indicators related to the device are masked. 

You can enable or disable devices using the Enable/Disable Devices dialog. You 
may have to sign on to the <local> station with sufficient clearance to access this 
dialog. Whether or not this is the case depends on the user privilege settings, 
maintained by the administrator. 

To show theEnable/Disable Devices dialog, select “Devices...” from the “Settings” 
menu. 

 

▪ Devices on: 
Select the serial port to which the device is attached. 

▪ Enabled devices: 
Place a check mark next to all devices that you want enabled. Remove any 
check marks next to devices you want disabled. The devices do not actually get 
enabled or disabled until you press the “OK” or “Apply” button. 

▪ The “Apply” button: 
Press this button to apply your changes. 

▪ The “Revert” button: 
Press this button to revert all check boxes you changed. This will undo all chang-
es you made since the last time you pressed the “Apply” button, or since you 
opened the dialog. 
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Masking and Unmasking Data 

Not all alarms and other information may be appropriate at all times. You can 
keep U.P.M.A.C.S. from processing any particular piece of information by mask-
ing it. This will change its appearance on the screen, and will keep U.P.M.A.C.S. 
from doing any logging and automatic controlling associated with the piece of in-
formation. If you mask an alarm, it will no longer trigger the audible alarm. 

You can mask or unmask alarms using the Mask/Unmask Data dialog. You may 
have to sign on to the <local> station with sufficient clearance to access this dia-
log. Whether or not this is the case depends on the user privilege settings, main-
tained by the administrator. 

You can also click on an indicator with the right mouse button and select the ap-
propriate context menu option to mask or unmask the data it displays. To do this 
you will need the same clearance that are required to view the Mask/Unmask Da-
ta dialog. 

To show theMask/Unmask Data dialog, select “Mask Data...” from the “Settings” 
menu. 

 

▪ Please check masked data: 
Place a check mark next to any data you want to be masked. Remove the 
checkmark to unmask the data. 

The data does not actually get masked or unmasked until you press “OK.” 

Calibration 

Some analog data may be available for calibration. 

You can calibrate analog values using the Calibration dialog. You may have to 
sign on to the <local> station with sufficient clearance to access this dialog. 
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Whether or not this is the case depends on the user privilege settings, main-
tained by the administrator. 

To show theCalibration dialog, select “Calibrate...” from the “Settings” menu. 

To calibrate an analog value, proceed as follows: 

 

1. Decide where you would like to add calibration points. 

2. Adjust you equipment until you have reached the first value where you 
would like to add a calibration point. 

3. Measure the actual value at the equipment using a calibrated meter. If 
you equipment has a built-in calibrated display, read the value off the 
display. 

4. Enter the actual value in the dialog. 

5. Press the “Set” button to add the calibration point. If you add a calibra-
tion point for a raw value for which you already defined a point, the old 
point is replaced with the new one. 

6. Repeat for all calibration points. 

7. Press the “Plot...” button to view the calibration curve and verify that it is 
satisfactory. 

8. Press the “Apply” or “OK” button to apply the calibration. 
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▪ Calibration data for: 
Select the value you wish to calibrate. 

▪ Raw value: 
Shows the current raw (uncalibrated) value. To add a calibration point, adjust 
your equipment until you have reached the value where you would like to add the 
point. If you add a calibration point for a raw value for which you already defined 
a point, the old point is replaced with the new one. 

▪ Current value: 
Shows the current calibrated value using the calibration points you have added 
so far, if any. Use this field to determine whether you should add more points. 

▪ New value: 
To add a calibration point for the current raw value, enter the desired calibrated 
value here, and press the “Set” button. If you add a calibration point for a raw 
value for which you already defined a point, the old point is replaced with the new 
one. 

▪ The “Set” button: 
Press this button to add a calibration point at the current raw value and the cali-
brated value you entered in the “New value” field. If you add a calibration point 
for a raw value for which you already defined a point, the old point is replaced 
with the new one. 

Changes you make to the calibration points will not be applied to the actual value 
in the station until you press the “Apply” or “OK” button. 
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▪ Calibration points: 
Shows a list of all calibration points you have added. 

▪ The “Plot” button: 
Press this button to view a graph of the calibration function. Here is an example 
of a plot: 

 

The red marks represent the calibration points you specified. The blue line repre-
sents the calibration function calculated from those points. 

▪ The “Delete” button: 
Press this button to delete all calibration points selected in the “Calibration 
points” field. You can select multiple points by holding down the Shift or Ctrl key 
and clicking on them. 

Changes you make to the calibration points will not be applied to the actual value 
in the station until you press the “Apply” or “OK” button. 

▪ The “Apply” button: 
Press this button to apply your changes to the calibration points to the actual val-
ue in the station. 

▪ The “Revert” button: 
Press this button to revert to the last applied calibration points. This will undo all 
changes you made since the last time you pressed the “Apply” button, or since 
you opened the dialog. 
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▪ The “Default” button: 
Press this button to revert to the calibration points specified in the station file. 
This will undo any calibration you ever did to the value. The changes will not take 
effect until you press the “Apply” or “OK” button. 

Setting Analog Limits 

Some analog data may be available for setting trip limits. A value that goes be-
yond its trip limits will trigger an alarm or other action. The exact effect of the lim-
its depends on the station file; refer to the documentation provided with the sta-
tion file for details on the actions associated with different analog values. 

You can set analog trip limits using the High/Low Limits dialog. You may have to 
sign on to the <local> station with sufficient clearance to access this dialog. 
Whether or not this is the case depends on the user privilege settings, main-
tained by the administrator. 

To show theHigh/Low Limits dialog, select “Set Limits...” from the “Settings” 
menu. You can also right-click on an indicator that shows the value whose limits 
you want to change and select the appropriate context menu option. 

 

▪ Limits for: 
Select the value whose trip limits you wish to change. 

▪ Low limit: 
Enter the lower trip limit here. leave this field blank to remove the limit. The limit 
will not actually change until you press the “Apply” or “OK” button. 
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▪ High limit: 
Enter the upper trip limit here. leave this field blank to remove the limit. The limit 
will not actually change until you press the “Apply” or “OK” button. 

▪ The “Apply” button: 
Press this button to apply the trip limits you entered. 

▪ The “Revert” button: 
Press this button to revert to the last applied trip limits. This will undo all changes 
you made since the last time you pressed the “Apply” button, or since you 
opened the dialog. 

▪ The “Defaults” button: 
Press this button to revert to the trip limits specified in the station file. This will 
undo any changes you ever made to the value’s trip limits. The changes will not 
take effect until you press the “Apply” or “OK” button. 

Setting Response Times 

Some alarms or status may be available for setting response times. The re-
sponse time is the minimum amount of time a status or fault state change must 
last in order to be registered. An alarm with a response time of 1s, for example, 
will not register unless it persists for at least 1s. If the alarm is triggered and 
cleared within 1s, U.P.M.A.C.S. ignores it. This is useful to eliminate erroneous 
alarms due to relay chatter or noise. 

You can set response times using the Response Times dialog. You may have to 
sign on to the <local> station with sufficient clearance to access this dialog. 
Whether or not this is the case depends on the user privilege settings, main-
tained by the administrator. 

To show the Response Times dialog, select “Set Response Times...” from the 
“Settings” menu. You can also right-click on an indicator that shows the status or 
alarm whose response time you want to change and select the appropriate con-
text menu option. 
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▪ Response time for: 
Select the status or alarm whose response time you wish to change. 

▪ Response time: 
Enter the new response time, in seconds, here. You can enter fractions of a sec-
ond. The response time will not actually change until you press the “Apply” or 
“OK” button. 

▪ The “Apply” button: 
Press this button to apply the response time you entered. 

▪ The “Revert” button: 
Press this button to revert to the last applied response time. This will undo all 
changes you made since the last time you pressed the “Apply” button, or since 
you opened the dialog. 

▪ The “Defaults” button: 
Press this button to revert to the response time specified in the station file. This 
will undo any changes you ever made to the response time of the status or alarm 
. The change will not take effect until you press the “Apply” or “OK” button. 

User Configurable Data Objects 

Some station files provide user configurable data objects. These might include 
configurable names for channels or antennas, or they might provide room for fu-
ture expansion. These configurable objects may include status or alarm data, 
analog data, control functions, or other types of objects. 

You can configure user configureable data objects using the Configure Data dia-
log. You may have to sign on to the <local> station with sufficient clearance to 
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access this dialog. Whether or not this is the case depends on the user privilege 
settings, maintained by the administrator. 

To show the Configure Data dialog, select “Configure Data...” from the “Settings” 
menu. You can also right-click on an indicator that shows the data object you 
want to configure and select the appropriate context menu option. 

The figure below shows a data object with all possible configuration options. In 
reality, each data object will only allow you to configure some of the options be-
low. The fields for options that you cannot configure for a particular data object 
will not appear when you select that object. 

 

▪ Settings for: 
Select the data object you wish to configure. 

▪ Custom name: 
Check this checkbox to configure the data object’s name. Enter a descriptive 
name in the edit field. The name will be used when logging events related to that 
object, and it will appear on the screen where the data is displayed. 

If you configure a name for a data object, U.P.M.A.C.S. may ask you whether 
you wish to unmask the object when you press the “Apply” or “OK” button. Con-
verseley, U.P.M.A.C.S. may ask you if you wish to mask the object if you remove 
a previously configured name. 
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▪ Log a custom message when the data is on: 
Check this box to log a custom message when the data object is on or an alarm 
is triggered. Enter the new log message in the edit field. If you do not check this 
box, a default message will usually be logged. 

▪ Log a custom message when the data is off: 
Check this box to log a custom message when the data object is off or an alarm 
clears. Enter the desired log message in the edit field. If you do not check this 
box, a default message will usually be logged. 

▪ Custom units: 
Check this box to display custom units for an analog data object. Enter the units 
in the edit field. 

▪ Custom precision: 
Check this check box to change the number of digits displayed after the decimal 
point for an analog data object. Enter the desired number of decimals in the edit 
field. To show no decimals, enter “0”. 

▪ Invert: 
Check this check box to swap the on and off states or alarm and alarm clear 
states of the data object. This may be necessary, for example, if you wish to wire 
a normally open alarm contact into a spare alarm designed for normally closed 
contacts. 

▪ The “Apply” button: 
Press this button to apply the configuration data you entered. 

▪ The “Revert” button: 
Press this button to revert to the last applied configuration. This will undo all 
changes you made since the last time you pressed the “Apply” button, or since 
you opened the dialog. 

The User Database 

The user database is where information about registered users is kept. See Sign-
ing On As a Registered User on page 14 for details. 

When U.P.M.A.C.S. is first run, there is only one user in the database. This user 
is termed the “built-in” user, and by default his user name is “System administra-
tor.” 

The user database can only be maintained by users with administrator clearance. 
The built-in user always has administrator clearance, and you can assign admin-
istrator clearance to any number of other users as well. To modify the user data-
base, you must sign on to the <local> station with administrator clearance. 

The built-in user is the only user when U.P.M.A.C.S. is first run, but he does not 
have a password by default. This means that you cannot log on the regular way 
before you have configured a password for the built-in user. Use the emergency 
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sign-on procedure described in Signing On As a Registered User on page 14 to 
sign on the first time. 

Once you have signed on with administrator clearance, select “Users...” from the 
submenu “Security” of the “Settings” menu. This will cause the Users dialog to 
appear. 

 

▪ Users: 
Shows a list of all users. Select a user whose information you wish to change. 

▪ Name: 
Shows the name of the selected user. You can edit the name to change it. 

▪ Clearance: 
Choose the clearance of the selected user here. The clearance is used to deter-
mine the actions a user can perform. 

Users with administrator clearance can modify the user database, user privileg-
es, and network security settings. Administrator clearance is also required to 
switch time handling between local time and GMT. In addition, administrators can 
connect remote stations that can only be disconnected by administrators. 

The tasks which users with supervisor, operator, and no clearance can perform, 
depend on the user privilege settings. 

Users with no clearance (“None”) cannot perform any tasks for which you need to 
be signed on. Signing on as a user without clearance to the local computer usu-
ally has no effect on the actions that can be performed. Users without clearance 
are useful in three situations: 

 

1. U.P.M.A.C.S. may be configured to require a user name and password 
to connect from a remote computer. If this is the case, users without 
clearance can connect to the station. 



U.P.M.A.C.S. Operator’s Manual  Advanced Tasks 

 Page 34 

2. When you connect from a remote station, you cannot execute controls 
or acknowledge alarms if you are not signed on, even if those actions do 
not require signing on from the local computer. This is to prevent two 
users at different locations from executing controls simultaneously at 
cross-purpose. A remote user can sign on as a user without clearance 
to perform actions that do not require signing on when performed locally. 

3. When someone is signed on from a remote computer, no actions can be 
performed from the local computer, even actions that do not otherwise 
require signing on. You can sign off a remote user to regain control of 
the computer by signing on locally as any user, even one without clear-
ance. 

 

You cannot change the clearance of the built-in user. The built-in user always 
has administrator clearance. 

▪ Shift length: 
Enter the selected user’s shift length, as hours : minutes, here. The shift length 
determines how long a user can remain signed on. Once the shift has expired, 
the user will be signed off automatically. 

The shift length cannot be used to restrict a user’s access to the system, as he 
can sign back on immediately after having been signed off. The shift length is 
used to prevent unauthorized access to the system if an operator signs on and 
forgets to sign off before leaving his shift. 

▪ The “Change Password...” button: 
Press this button to change the selected user’s password. User passwords must 
be at least five characters long. The password must be entered twice, and is not 
shown as you type it. To change your own password, you must enter the old 
password as well. 

Any user can change his own password by signing on and selecting “Change 
Password...” from the submenu “Security” of the “Settings” menu. Even though 
the administrator can change any user’s password, there is no way you can find 
out the password a user entered. This is intended for users who like to use the 
same password that they use on other systems, e.g. their e-mail, and who do not 
want the password divulged. If a user forgets his password, you must assign a 
brand new one for him, rather than looking up the old one. 

▪ The “Delete” button: 
Press this button to delete the selected user. You cannot delete yourself, or the 
built-in user. 

▪ The “New...” button: 
Press this button to create a new user. You will be prompted for a user name and 
password. User passwords must be at least five characters long. The password 
must be entered twice, and is not shown as you type it. 

The new user will have neither clearance nor shift length. 
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User Privileges 

The user privileges determine what clearance is required to perform certain ac-
tions. You can assign a minimum required clearance for certain actions, like exe-
cuting controls, acknowledging alarms, or masking data. This will prevent unau-
thorized users from interfering with the operation of the M&C system. 

Some actions can only be performed by a user with administrator clearance, and 
you cannot change the minimum required clearance for them. Administrator 
clearance is always required to: 

 

1. modify the user database 

2. modify the user privileges 

3. modify the network security settings 

4. switch time handling between local time and GMT 

5. connect remote stations that can only be disconnected by users with 
administrator clearance 

6. disconnect such remote stations 

 

To modify the user privileges, you must sign on to the <local> station with admin-
istrator clearance. 

Once you have signed on with administrator clearance, select “Privileges...” from 
the submenu “Security” of the “Settings” menu. This will cause the User Privileg-
es dialog to appear. 
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For each action described in the left-hand column, select the minimum required 
clearance in the right-hand column. If you select “None”, the action can be per-
formed locally without signing on. Performing any action from a remote computer 
always requires sign on. 

▪ Acknowledge alarms: 
Select the minimum required clearance to acknowledge alarms. See Acknowl-
edging Alarms on page 17 for details. 

▪ Execute controls: 
Select the minimum required clearance to execute controls. See Executing Con-
trols on page 17 for details. 

▪ Port diagnostics: 
Select the minimum required clearance to perform Port Diagnostics. See Viewing 
Serial Port Information on page 19 for details. This clearance is also required to 
select the “slow down polling” option in the preferences. See Appendix A: Ad-
vanced Preferences on page 53 for detail. 

▪ Disable devices: 
Select the minimum required clearance to enable or disable devices. See Disa-
bling Devices on page 23 for details. 
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▪ Mask data: 
Select the minimum required clearance to mask or unmask data. See Masking 
and Unmasking Data on page 24 for details. 

▪ Calibrate analogs: 
Select the minimum required clearance to calibrate analog data. See Calibration 
on page 24 for details. 

▪ Set high/low limits: 
Select the minimum required clearance to set analog trip limits. See Setting Ana-
log Limits on page 28 for details. 

▪ Set response times: 
Select the minimum required clearance to change response times. See Setting 
Response Times on page 29 for details. 

▪ Configure data: 
Select the minimum required clearance to configure user configurable data ob-
jects. See User Configurable Data Objects on page 30 for details. 

▪ Change log file: 
Select the minimum required clearance to change the log file settings. See Ap-
pendix A: Logging Preferences on page 52 for details. 

▪ Configure uplink ports: 
Select the minimum required clearance to configure uplink ports. See Uplink 
ports on page 39 for details. 

Network Security 

You can set a number of options to increase the network security of 
U.P.M.A.C.S. to protect your station against intruders. To modify the network se-
curity settings, you must sign on to the <local> station with administrator clear-
ance. 

Once you have signed on with administrator clearance, select “Network...” from 
the submenu “Security” of the “Settings” menu. This will cause the Network Se-
curity Settings dialog to appear. 
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▪ Allow remote connections: 
Check this box to allow remote U.P.M.A.C.S. connections to this computer. If you 
leave this check box blank, no one can connect to the local station from a remote 
computer. 

Note: Leaving this check box blank does not affect insecure remote con-
trol (see below). Insecure remote control can still be performed if the “Al-
low insecure remote control” check box is checked, even if this check box 
is blank. 

▪ Require password to connect: 
Check this box to require a password when connecting from a remote computer. 
This will prevent unauthorized users from viewing your station. It is not necessary 
to check this box to prevent unauthorized users from controlling your stations, as 
executing controls and acknowledging alarms from a remote computer always 
require signing on with user name and password, regardless of the user privilege 
settings. This option is only necessary to prevent unauthorized users from view-
ing sensitive or proprietary information that may be contained in your station’s 
screens. 

▪ Allow remote sign on: 
Check this check box to allow users to sign on from a remote computer. If you 
leave this check box blank, no one can sign on from a remote computer. Since 
signing on is always required to execute controls or acknowledge alarms from a 
remote computer, regardless of the user privilege settings, remote computers are 
limited to monitoring only unless this check box is checked. 

▪ Allow insecure remote control: 
U.P.M.A.C.S. has the capability of allowing a local station on another computer 
on the network to execute controls on the local station on this computer. The re-
mote user is not required to log on to do so, which can pose a security risk. For 
this reason, this capability is disabled by default. 

If you require that a station running on another computer be able to execute con-
trols on this computer, you must check this box. 

U.P.M.A.C.S. can interface with certain other applications via a protocol called 
the RTS protocol, which also allows execution of controls without logging on. To 
execute RTS controls, you must check this box as well. The RTS protocol is a 
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highly specialized option, and requires third-party software specifically designed 
to exploit it. 

It is not necessary to check this box to execute controls in the normal fashion, 
even from a remote computer. 

Uplink ports 

Certain U.P.M.A.C.S. station files support uplink ports. Third-party systems can 
send data queries and commands to U.P.M.A.C.S. via one or more serial ports 
using a special serial protocol based on Scientific Altlanta’s SABus protocol. The 
exact nature of the commands and queries supported is specified in the station 
file, and differs from station to station. 

If a system needs to poll or command U.P.M.A.C.S. via a serial port, that port 
must be configured as an uplink port. 

You can configure any serial port or ports as uplink ports using the Uplink Ports 
dialog. You may have to sign on to the <local> station with sufficient clearance to 
access this dialog. Whether or not this is the case depends on the user privilege 
settings, maintained by the administrator. 

To show the Uplink Ports dialog, select “Uplink Ports...” from the “Settings” menu. 

 

▪ Serial ports: 
Shows a list of all serial ports available on the computer. Ports configured as up-
link ports have a picture of a red megaphone next to them. Ports used to monitor 
the equipment of the station are shown in grey, with a picture of a serial cable 
connector next to it. 
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▪ Use as uplink port: 
Check this check box to use the port as an uplink port, or clear it to stop using it  
as an uplink port. When you check the box, a dialog will appear to allow you to 
configure the communications settings of the port. See The Uplink Port Settings 
Dialog on page 40 for a description of this dialog 

▪ Baud rate: 
Shows the data rate setting of the port. 

▪ Data bits: 
Shows the number of data bits used on the port. 

▪ Parity: 
Shows the parity setting of the port. 

▪ Stop bits: 
Shows the number of stop bits used on the port. 

▪ Flow control: 
Shows the flow control setting of the port. RTS/DTS and DTR/DSR are hardware 
flow control, XON/XOFF is software flow control. 

▪ SABus address: 
Shows the SABus device address used to address U.P.M.A.C.S.. The device 
address is one of the fields used in the SABus protocol, and has to be specified 
by the system that needs to communicate with U.P.M.A.C.S.. 

▪ Clearance: 
Shows the clearance of the port. This determines the actions that can be per-
formed via this serial port, just like the user clearance determines the actions a 
user can take. See User Clearance on Page 14 for details. 

The Uplink Port Settings Dialog 

When you check the “Use as uplink port” check box to use a serial port as an up-
link port, the Uplink Port Settings dialog will appear to allow you to specify the 
settings of the new port. 
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▪ Baud rate: 
Select the data rate setting of the port. 

▪ Data bits: 
Select the number of data bits used on the port. 

▪ Parity: 
Select the parity setting of the port. 

▪ Stop bits: 
Select the number of stop bits used on the port. 

▪ Flow control: 
Select the flow control setting of the port. RTS/DTS and DTR/DSR are hardware 
flow control, XON/XOFF is software flow control. 

▪ SABus address: 
Enter the SABus device address used to address U.P.M.A.C.S. via this port. The 
device address is one of the fields used in the SABus protocol, and has to be 
specified by the system that needs to communicate with U.P.M.A.C.S.. 

You can enter the address as a hexadecimal or a decimal number. Use the “Hex” 
or “Decimal” radio buttons to switch between the two bases. 
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▪ Clearance: 
Select the clearance of the port. This determines the actions that can be per-
formed via this serial port, just like the user clearance determines the actions a 
user can take. See User Clearance on Page 14 for details. 

The default setting is “None.” This will usually mean that no controls can be exe-
cuted via this uplink port. Make sure to change the clearance setting to match the 
needs of the system that will use the port to talk to U.P.M.A.C.S.. 
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MENUS AND TOOL BARS 

The File Menu 

▪ Close Window: 
Closes the current screen window. This does not close the U.P.M.A.C.S. Operate 
System window. 

▪ Open Station: 
Opens a station file. 

▪ Close Station: 
Stops monitoring the current station and closes the file. 

▪ Page Setup: 
Lets you to modify the print margins, scaling factors, etc., of printed screens. 

▪ Print: 
Prints the current screen. 

▪ Sign On: 
Lets you sign on as a registered user. 

▪ Sign Off: 
Lets you sign off. 

▪ Connect To: 
Lets you connect to a remote computer. 

▪ Remote Stations: 
Lets you view and close connections to remote computers. 

▪ List of recently opened files: 
Lets you open a station file you recently used. 

▪ Exit: 
Stops monitoring the current station and exits the U.P.M.A.C.S. Operate System. 

The View Menu 

▪ Tool Bar: 
Shows or hides the Tool Bar. 

▪ Status Bar: 
Shows or hides the Status Bar. 

▪ Log Window: 
Shows or hides the Log window. 

▪ Remote Station Status: 
Shows or hides the Remote Station Status window. 
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▪ Previous Screen: 
Changes the screen shown in the current window to the previous screen in the 
alphabet. 

▪ Next Screen: 
Changes the screen shown in the current window to the next screen in the al-
phabet. 

▪ Next Alarm: 
Shows the screen with the next unacknowledged alarm on it. Selecting this op-
tion repeatedly will show you all unacknowledged alarms in sequence. 

▪ Log File Browser: 
Open the U.P.M.A.C.S. Log File Browser and loads the current log file. 

The Settings Menu 

▪ Security: 
Allows you to access the following options: 

Change Password: 
Allows you to change your password. You must be signed on to the <local> sta-
tion to select this option. 

Users: 
Allows you to modify the user database. You must be signed on to the <local> 
station with administrator clearance to select this option. 

Privileges: 
Allows you to modify the user privileges. You must be signed on to the <local> 
station with administrator clearance to select this option. 

Network: 
Allows you to modify the network security settings. You must be signed on to the 
<local> station with administrator clearance to select this option. 

▪ Preferences: 
Allows you to modify the preferences. 

▪ Uplink Ports: 
Allows you to configure uplink ports. 

▪ Image Library: 
Allows you to change the currently used image library. See Appendix C: Image 
Libraries on page 62 for details. 

▪ Serial Ports: 
Allows you to view information about serial ports and perform port diagnostics. 
You may have to be signed on to the <local> station with sufficient clearance to 
select this option. 
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▪ Devices: 
Allows you to enable and disable devices. You may have to be signed on to the 
<local> station with sufficient clearance to select this option. 

▪ Mask Data: 
Allows you to mask and unmask data. You may have to be signed on to the <lo-
cal> station with sufficient clearance to select this option. 

▪ Calibrate: 
Allows you to calibrate analog data. You may have to be signed on to the <local> 
station with sufficient clearance to select this option. 

▪ Set Limits: 
Allows you to set analog trip limits. You may have to be signed on to the <local> 
station with sufficient clearance to select this option. 

▪ Set Response Times: 
Allows you to change response times. You may have to be signed on to the <lo-
cal> station with sufficient clearance to select this option. 

▪ Configure Data: 
Allows you to configure user configurable data objects. You may have to be 
signed on to the <local> station with sufficient clearance to select this option. 

The Window Menu 

▪ New Window: 
Allows you to open another window. You will be asked to select a screen for the 
window. 

▪ Auto Size: 
Adjusts the size of the current window to fit the size of the screen it displays. 

▪ Capture: 
Places the current screen on the clipboard as an image. See Capturing And 
Printing Screens on page 18 for details. 

▪ Acknowledge Alarms: 
Acknowledges all alarms on the current screen. 

▪ Cascade: 
Arranges all windows so that they overlap. 

▪ Tile Horizontally: 
Arranges all windows as horizontal non-overlapping tiles. 

▪ Tile Vertically: 
Arranges all windows as vertical non-overlapping tiles. 

▪ Arrange Icons: 
Arranges all minimized windows at the bottom of the U.P.M.A.C.S. Operate Sys-
tem window. 
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▪ Close All: 
Closes all screen windows. This does not close the U.P.M.A.C.S. Operate Sys-
tem window. 

▪ Close others: 
Closes all screen windows except the one you are currently viewing. This does 
not close the U.P.M.A.C.S. Operate System window. 

▪ List of open windows: 
Allows you to bring a specific window to the front. 

The Help Menu 

▪ U.P.M.A.C.S. Help: 
Shows the U.P.M.A.C.S. Operate System help file. 

▪ About U.P.M.A.C.S.: 
Shows the version and copyright information for the version of the U.P.M.A.C.S. 
Operate System you are currently running. 

The Tool Bar 

acknowledge

alarms

next

alarm

the screen

pop-up menu

next

screen

toggle

log

log file

browser

previous

screen

autosize

window

toggle

remote station

status

cascade

windows

tile

horizontally

tile

vertically

 

The Tool Bar is a “dockable” window. You can grab its frame, and “tear” it away 
from the U.P.M.A.C.S. window, to float in its own little window. If the Tool Bar is 
floating, you can “dock” it to the U.P.M.A.C.S. window again by moving it near 
the U.P.M.A.C.S. menu bar. You can also double-click in the title bar of the Tool 
Bar to dock it. 

If you want to prevent the Tool Bar from docking itself when you drag it, hold 
down the Ctrl key. 

To hide the Tool Bar, or to show it once you hid it or closed its floating window, 
select “Tool Bar” from the “View” menu. 

▪ Acknowledge alarms: 
Acknowledges all alarms on the current screen. 
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▪ Next alarm: 
Shows the screen with the next unacknowledged alarm on it. Selecting this op-
tion repeatedly will show you all unacknowledged alarms in sequence. 

▪ The screen pop-up menu: 
Allows you to change the screen shown in the current window. 

▪ Previous screen: 
Changes the screen shown in the current window to the previous screen in the 
alphabet. 

▪ Next screen: 
Changes the screen shown in the current window to the next screen in the al-
phabet. 

▪ Auto size: 
Adjusts the size of the current window to fit the size of the screen it displays. 

▪ Toggle log: 
Shows or hides the Log window. 

▪ Toggle remote station status: 
Shows or hides the Remote Station Status window. 

▪ Log file browser: 
Open the U.P.M.A.C.S. Log File Browser and loads the current log file. 

▪ Cascade windows: 
Arranges all windows so that they overlap. 

▪ Tile horizontally: 
Arranges all windows as horizontal non-overlapping tiles. 

▪ Tile vertically: 
Arranges all windows as vertical non-overlapping tiles. 

The Status Bar 

alarm

indicator

sign-on

information

current

date

current

time
 

To hide the Status Bar, or to show it once you hid it, select “Status Bar” from the 
“View” menu. 

▪ Alarm indicator: 
Reads “ALARM” if there are any unacknowledged alarms on any screen. 
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▪ Sign-on information: 
Shows the user name and time left in the shift, if any, for the station that the cur-
rent screen belong to. If no windows are open, shows the sign-on information for 
the <local> station. 

▪ Current date: 
Shows the current date. If time handling is set to GMT, shows the current GMT 
date. See Appendix A: Advanced Preferences on page 53 for details. 

▪ Current time: 
Shows the current time. If time handling is set to GMT, shows the current GMT 
time. See Appendix A: Advanced Preferences on page 53 for details. 
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APPENDICES 

Appendix A: Preferences 

The preferences let you configure various aspects of the operation of 
U.P.M.A.C.S.. To change the preferences, select “Preferences...” from the “Set-
tings” menu. 

The preferences window has three pages. you can access each page by clicking 
on its tab, at the top of the window. 

tab for the

general preferences

page

tab for the

logging preferences

page

tab for the

advanced preferences

page

 

The tabs for the three preference pages 

General Preferences 

The General Preferences page allows you to adjust certain general aspects of 
the operation of U.P.M.A.C.S.. 
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▪ Resize window when changing screens: 
Check this box to resize windows automatically to fit the new screen when you 
change screens using the Previous Screen or Next Screen menu items, or the 
Screen pop-up menu on the Tool Bar. If you leave this field blank, the window will 
stay the same size when you change screens, and the new screen may not fit 
inside the window. You can always view the hidden parts of a screen using the 
scroll bars. 

▪ Use PC speaker for alarm sound: 
Check this box if you do not have a sound card, or if you do not have speakers 
for your sound card. U.P.M.A.C.S. will use the built-in PC speaker to generate 
the alarm sound rather than the sound card. Before checking this box, make sure 
your computer has a built-in speaker, and that it is powerful enough. Most mod-
ern PCs have no or very weak speakers. 

▪ Pop to foreground when an alarm occurs: 
Check this box to cause U.P.M.A.C.S. to pop to the foreground, above all other 
running programs and open windows, whenever an alarm occurs. If you check 
this box, U.P.M.A.C.S. will also wake up the screen saver when an alarm occurs. 

▪ Alarm blink rate: 
Slide the slider to adjust the rate at which alarms blink. There is a sample alarm 
to the right of the slider, adjust the blink rate until the sample alarm blinks to your 
satisfaction. 

The blink rate also determines the rate at which the alarm beep is repeated. 

▪ The “Sounds...” button: 
Press this button to launch the Windows Sounds control panel. 
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The Windows Sounds control panel 

To configure U.P.M.A.C.S. sounds, including the alarm sound, scroll the “Events” 
list down until you find the entries for “U.P.M.A.C.S.” You can select sounds for 
the following events: 

Alarm: 
This sound is used to create the audible alarm. If you remove this sound, the sys-
tem beep will be used instead. 

Remote Connection Closed: 
This sound is played when you close a remote station. 

Remote Connection Established: 
This sound is played as soon as a remote station has established a successful 
connection with a remote computer. 

Remote Connection Lost: 
This sound is played when a remote station looses communication with the re-
mote computer. If you remove this sound, the system beep will be used instead. 
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Serial Port Timeout: 
This sound is played when a serial device times out. 

Serial Port Timeout Cleared: 
This sound is played when a serial device that timed out is communicating again. 

Logging Preferences 

The Logging Preferences page allows you to adjust the settings for the log file 
and log window. You may have to sign on to the <local> station with sufficient 
clearance to modify most of the settings. Whether or not this is the case depends 
on the user privilege settings, maintained by the administrator. 

 

▪ Log file: 
Shows the current log file. Press the “Browse...” button to change the log file. 
You may have to be signed on to the <local> station with sufficient clearance to 
change the log file. 

▪ The “Browse...” button: 
Press this button to change the log file. You may have to be signed on to the <lo-
cal> station with sufficient clearance to press this button. 

▪ Maximum file size: 
Check this box to limit the size of the log file. If you do not check this box, the log 
file will grow until your disk is full. Enter the maximum size of the log file, in kilo-
bytes, into the edit field. 

Once the log file has exceeded the specified size, the older half of log messages 
is deleted from the file. For example, if you specified 4096 kB (4 MB) as the log 
file size, 2048 kB worth of log file messages will be deleted as soon as the file 
size exceeds 4096 kB. This will reduce the log file size to 2048 kB. 
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You may have to be signed on to the <local> station with sufficient clearance to 
modify this options. 

▪ Warn when log file is nearly full: 
Check this box if you want a warning to appear if the log file has nearly reached 
the size specified in the “Maximum file size” edit field. 

You may have to be signed on to the <local> station with sufficient clearance to 
change this options. 

▪ Log window size: 
Enter the number of messages that should be shown in the log window. If you set 
the size to 500 lines, for example, the 500 most recent messages will be visible 
in the log window. This option is always available, and you do not need to sign on 
to modify it. 

Advanced Preferences 

The Advanced Preferences page allows you to adjust certain advanced aspects 
of the operation of U.P.M.A.C.S.. 

 You may have to be signed on to the <local> station with sufficient clearance to 
modify some of the settings. 

 

▪ Use GMT: 
Check this box to have U.P.M.A.C.S. perform all time and date processing in 
Greenwich mean time (GMT). If you check this box, the date stamps of log mes-
sages, the time and date in the status bar, and all other time and date processing 
that your station may require, will be done in GMT rather than local time. 

You must be signed on to the <local> station with administrator clearance to 
change this setting. 
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▪ Connect dialog allows multiple computers: 
Check this box to use the variant of the Connect Remote Station dialog that al-
lows connections to multiple computers as described in Redundant Remote 
Computers on page 6. This setting does not affect any stations already open, it 
only changes the appearance of the Connect Remote Station dialog. If you leave 
this check box blank, the simple Connect Remote Station dialog described in 
Connecting to a Single Computer on page 4 will be used. 

▪ Show only local computers in connect dialog: 
This check box affects the way U.P.M.A.C.S. looks for remote stations that are 
available on the network. If you check this check box, U.P.M.A.C.S. will use 
UDP/IP broadcast messages to locate available stations. Broadcast messages 
are usually not transmitted outside a LAN, so computers outside the local net-
work will not appear. 

If you leave this check box blank, U.P.M.A.C.S. will remember a list of computers 
that you have connected to in the past, and query each of them to see whether a 
station is available on that computer. This will enable computers outside your 
LAN to appear in the list of available computers, as long as you have connected 
to them previously. 

U.P.M.A.C.S. specifically queries computers when this check box is blank. If you 
have a dial-on-demand connection to the Internet, this may cause your auto dial-
er to dial in every time you open the Connect Remote Station dialog. If you expe-
rience this problem, check this box. 

▪ Slow down polling: 
U.P.M.A.C.S. usually sends a new command to a serial port immediately after 
receiving a response to the previous command. With some poorly designed 
hardware configurations, this may cause problems. Check this check box to force 
a 10ms delay between receiving a response and sending out the next command. 

If a delay greater than 10ms is needed, the station file will have to be modified 
accordingly. 
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Appendix B: Data Capture Utility Reference 

U.P.M.A.C.S. has a built-in data capture utility that can serve as a protocol ana-
lyzer. The utility allows you to monitor and record all data transactions on a serial 
port with time stamp. This can be useful for debugging serial communications 
problems. To use the data capture utility, press the “Capture Data” button in the 
Port Diagnostics dialog. See Viewing Serial Port Information on page 19 for a 
description of the Port Diagnostics dialog. 

 

The Data Capture window is an entirely separate top-level window. It is not con-
tained within the U.P.M.A.C.S. Operate System window, and has its own button 
on the Windows Taskbar. The Data Capture window also has its own menu bar 
with its own menus, and its own tool bar. 

You can have as many data capture windows as you want open at the same 
time. The title bar of each window shows the name of the serial port whose data 
it displays, followed by the hardware port (COM port) in brackets. 

Besides capturing data transactions, the Data Capture window allows you to 
suspend and resume the polling process on the port, and to send the polling se-
quence one command at a time. 

You can save data you captured to disk, or you can print it out. You can also se-
lect lines of data and copy them to the clipboard, so that you can paste them into 
a word processor or similar program. 
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How Data Is Displayed 

The data in the Data Capture windows is displayed on a command-by-command 
basis. Whenever a command is sent to the equipment, a message with time 
stamp appears in the window. The line after the message shows the command 
data that was sent. Messages are shown on grey background, data on white. 
When a response is received, or the command times out, another message with 
time stamp appears, followed by a line with the data received. (If a command 
does not expect a response, only a message appears.) 

The command and response data is colour coded as follows: 

 

Blue: data sent to the equipment 

Grey: garbage and line noise 

Green: valid data received from the equipment 

Red: error messages received from the equipment 

Black: synchronization bytes, address bytes, checksums, etc. 

 

You can choose between two ways of displaying the data. The data can either be 
shown as ASCII text, or as a series of hexadecimal values. 

Text Display 

You can switch to text display by selecting “Show As Text” from the “Port” menu. 

 

In text mode, the data is shown as ASCII text, if possible. Bytes that cannot be 
shown as ASCII text (non-printable characters) are displayed as special charac-
ter sequences. All the special sequences begin with a backslash (‘ \ ‘). 

 

Sequence Character Code (hexadecimal) 

\0 null character 00 

\b backspace 08 

\t tab 09 

\n linefeed 0A 
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\v vertical tab 0B 

\f form feed 0C 

\r carriage return 0D 

 

Any other non-printable character is shown using \x followed by two hexadecimal 
digits specifying the character code. Here are some examples: 

 

Sequence Character Code (hexadecimal) 

\x02 start transmission 02 

\x03 end of transmission 03 

\xFF delete  FF 

\xB7 ASCII B7 B7 

 

Since the backslash character is used to start special character sequences, it 
needs a sequence of its own. The backslash character is displayed as a double 
backslash: 

 

Sequence Character Code (hexadecimal) 

\\ backslash 92 

 

Hexadecimal Display 

You can switch to hex display by selecting “Show As Hex” from the “Port” menu. 

 

In hexadecimal mode, the data is simply shown as a series of hexadecimal num-
bers. 

Limitations 

There are two situations in which data may not be displayed in the Data Capture 
window: 

▪ Outgoing line noise: 
The Data Capture utility can record extra characters due to line noise received by 
U.P.M.A.C.S. from the equipment. Line noise received by the equipment, howev-
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er, cannot be recorded, since it is created after the data has left the computer. 
Outgoing line noise will not appear in the data capture window. 

▪ Over-long response data: 
U.P.M.A.C.S. allocates a certain amount of buffer space (specified in the station 
file) for each command. Once the buffer is full (buffer overflow), characters are 
removed from the beginning of the buffer to make room for new characters. 
Bytes that are removed from the buffer due to a buffer overflow will not appear in 
the Data Capture window. 

The Data Capture Window’s Menus 

The File Menu 

▪ Save As: 
Lets you save the content of the window. You must stop the data capture to se-
lect this option. 

▪ Save Selection: 
Lets you save the selected lines. You must stop the data capture to select this 
option. 

▪ Print Setup: 
Lets you select the printer and printing options for printing the captured data. 

▪ Print: 
Prints the captured data, or the selected data. You must stop the data capture to 
select this option. 

▪ Close: 
Closes the Data Capture window. 

The Edit Menu 

▪ Show Tool Bar: 
Shows or hides the Data Capture Tools. 

▪ Copy: 
Copies the currently selected lines to the clipboard. 

▪ Select All: 
Selects all lines in the window. 

The Port Menu 

▪ Clear Data: 
Clears the window. 

▪ Show As Hex: 
Displays data as hex numbers. This affects only newly captured messages; exist-
ing messages remain unchanged. 
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▪ Show As Text: 
Displays data as ASCII text. This affects only newly captured messages; existing 
messages remain unchanged. 

▪ Start Capture: 
Starts capturing data. This does not affect the polling process; if polling is sus-
pended, you will not see any data. 

▪ Stop Capture: 
Stops capturing data. This does not affect the polling process. Polling will contin-
ue, but the data will not appear in the window. 

▪ Suspend: 
Suspends the polling process on the port. If polling is suspended, no polls are 
sent. Polling will be resumed automatically when you close the Data Capture 
window, unless you are viewing the port in the Port Diagnostics dialog. 

▪ Resume: 
Resume the polling process on the port if it was suspended. 

▪ Send One Command: 
Sends one command to the serial port. This command is either the next com-
mand in the polling sequence, or a command that a control is waiting to send. 
Polling must be suspended to select this option. 

The Help menu 

▪ U.P.M.A.C.S. Help: 
Shows the U.P.M.A.C.S. Operate System help file. 

▪ Data Capture Help: 
Shows this section of the U.P.M.A.C.S. Operate System help file. 

▪ About U.P.M.A.C.S.: 
Shows the version and copyright information for the version of the U.P.M.A.C.S. 
Operate System you are currently running. 
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The Data Capture Tool Bar 

save as

print

copy stop

capture

show as

hex

resume

polling

start

capture

show as

text

suspend

polling

send one

command

 

The Data Capture Tool Bar is a “dockable” window. You can grab its frame, and 
“tear” it away from the Data Capture window, to float in its own little window. If 
the tool bar is floating, you can “dock” it to the Data Capture window again by 
moving it near the window’s menu bar. You can also double-click in the title bar 
of the Data Capture Tools window to dock it. 

If you want to prevent the tool bar from docking itself when you drag it, hold down 
the Ctrl key. 

To hide the Data Capture Tool Bar, or to show it once you hid it or closed its 
floating window, select “Show Tool Bar” from the “Edit” menu. 

▪ Save as: 
Lets you save the content of the window. You must stop the data capture to 
press this button. 

▪ Print: 
Prints the captured data, or the selected data. You must stop the data capture to 
press this button. 

▪ Copy: 
Copies the currently selected lines to the clipboard. 

▪ Start capture: 
Starts capturing data. This does not affect the polling process; if polling is sus-
pended, you will not see any data. 

▪ Stop capture: 
Stops capturing data. This does not affect the polling process. Polling will contin-
ue, but the data will not appear in the window. 

▪ Show as text: 
Displays data as ASCII text. This affects only newly captured messages; existing 
messages remain unchanged. 

▪ Show as hex: 
Displays data as hex numbers. This affects only newly captured messages; exist-
ing messages remain unchanged. 
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▪ Suspend polling: 
Suspends the polling process on the port. If polling is suspended, no polls are 
sent. Polling will be resumed automatically when you close the Data Capture 
window, unless you are viewing the port in the Port Diagnostics dialog. 

▪ Resume polling: 
Resume the polling process on the port if it was suspended. 

▪ Send one command: 
Sends one command to the serial port. This command is either the next com-
mand in the polling sequence, or a command that a control is waiting to send. 
Polling must be suspended to press this button. 
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Appendix C: Image Libraries 

Prior to v6.0, most stations used images from an image library. Pictures of wave-
guide switches, satellite dishes, filters, combiners, and similar things in the sta-
tion file were loaded from the image library. If the image library did not contain 
the required pictures, the station did not look as intended. 

Station files created with the U.P.M.A.C.S. Development System prior to v6.0 still 
require the use of an external image library. If switches, satellite antennas and 
the like are missing from your screens, it is likely that your station file requires an 
image library. In this case, the appropriate image library should have been deliv-
ered with the station file. The icon for image libraries looks like this: 

 

The U.P.M.A.C.S. image library icon 

If you do not know what image library to use, get in contact with the party that 
supplied your station file. 

When U.P.M.A.C.S. is first run, it uses no image library, and all images in older 
station files are replaced with a default image. To select the image library the im-
ages are loaded from, you must choose “Image Library...” from the “Settings” 
menu. The Image Library dialog will appear. 

 

▪ Select image library: 
Shows the path name of the current image library, if any. Type the path name of 
the new library here. You can select a path name you recently entered from a 
drop down menu by clicking on the button with the down arrow. 

You can also press the “Browse...” button to select a library from a file dialog. 
This is usually easier and more convenient than typing in a path name. 

▪ Update local screens: 
Check this check box to update the screens of the station that is currently loaded 
with the new images. If you leave this check box blank, the new library will be 
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used for any stations you open later, but not for the station that is currently being 
monitored. 

▪ The “Browse...” button: 
Press this button if you wish to select an image library using a file dialog, rather 
than typing the path name in directly. This is usually easier and more convenient. 

▪ The “Use None” button: 
Press this button to use no image library. This may be necessary if you deleted 
the image library you last specified. 

Images from a remote station 

When connecting to a remote station that is running a version of U.P.M.A.C.S. 
prior to v5.5.0, you will also require the correct image library. The same image 
library that is used when loading older station files is also used when connecting 
to older versions of U.P.M.A.C.S.. 

U.P.M.A.C.S. v5.5.0 and higher will transmit the images over the network, so it is 
not necessary to use an image library when connecting to a station that uses 
U.P.M.A.C.S. v5.5.0 or higher. 

Versions of U.P.M.A.C.S. prior to v5.5.15 did not support cashing of remote sta-
tions. (See Connecting To a Remote Station on page 3 for details). To reduce the 
time it takes to transmit a remote station that is running a version of U.P.M.A.C.S. 
prior to v5.5.15, you can check the “Use local images” option in the “Connect 
to...” dialog. U.P.M.A.C.S. will then use images from the local image library rather 
than receiving them over the network. 
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CONTACT INFORMATION 

U.P.M.A.C.S. Communications Inc. 

714, 36th Ave., Suite 301 
Lachine, QC, Canada 
H8T 3L8 
 
Tel: 1-514-697-5500 
E-Mail: support@upmacs.com 
 
UPMACS is on the Web at http://www.upmacs.com 

This manual and the U.P.M.A.C.S. software package are 
©2025 by UPMACS Communications Inc. 

mailto:support@upmacs.com
http://www.upmacs.com/
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